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Introduction

WaveCenter/PCI™ is a PCI soundcard that
integrates these digital audio and MIDI features:

• One optical input and one optical output for digital
audio (either 8-channel ADAT optical audio, or
2-channel SPDIF optical audio)

• One RCA (coax) input and one RCA (coax) output
for 2-channel SPDIF audio

• One 8-pin port with a breakout cable for
2 MIDI inputs and 2 MIDI outputs

Either optical port can be switched from
multichannel ADAT optical format to stereo
SPDIF format for connectivity with CD players,
DAT machines, MiniDisc recorders, or any other
TOSLINK-compatible equipment.

WaveCenter/PCI includes a cable that lets you transfer digital audio
directly from a CD-ROM or DVD drive, provided that the drive has a
compatible 2-pin digital audio output.

WaveCenter/PCI supports 44.1 and 48 kHz sample rates, and
dynamically resamples 8, 11.025, 16, 22.05 and 32 kHz digital audio
output for playback through high-quality external converters.
WaveCenter/PCI can also lock to digital audio inputs from 39–51 kHz.

WaveCenter/PCI provides software controls for digital audio input
status, source and destination formats, and sample rate. It is also
bundled with Cool Edit Pro SE, a multichannel recording and editing
application from Syntrillium Software.
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WaveCenter/PCI’s ASIO driver provides low-latency performance when
adjusting parameters and monitoring inputs with applications such as
Cubase VST. WaveCenter/PCI also has a direct GigaSampler Interface
driver.

The ADAT optical ports on WaveCenter/PCI can be connected to any
device that also has ADAT optical ports, including digital mixers, ADAT-
compatible tape machines, digital format translators (such as the
Apogee FC-8 for TDIF/ADAT translations), and external A/D & D/A
converters such as Frontier Design Group’s Tango24™ and Zulu™.

In addition to this User’s Guide, your WaveCenter/PCI package should
contain:

• WaveCenter/ PCI circuit board

• Breakout cable for 2 MIDI inputs and 2 MIDI outputs (4 standard 5-pin
MIDI jacks); connects to WaveCenter/PCI’s 8-pin circular connector

• Internal cable for CD-ROM or DVD digital audio

• Envelope containing WaveCenter/PCI software on a 3.5" floppy disk
(please read the envelope before opening it)

• CD-ROM with Cool Edit Pro SE recording/editing software and demo
versions of industry-leading audio production software
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About the Company
Frontier Design Group develops, manufactures and sells digital audio
hardware and software. Our goal is to provide high-quality, high-value
tools to help our customers be more creative and productive.

We’re always interested in receiving your feedback on our products,
as well as your suggestions for improvements and new products.
You can send email to feedback@frontierdesign.com or send a
fax to 603-448-6398.

Technical Support
If you have any problems or questions that aren’t addressed in the
Troubleshooting chapter or elsewhere in this Guide, there are three
ways to get more help:

• Refer to our web site (http://www.frontierdesign.com) for
information on current revisions, answers to frequently asked
questions, troubleshooting procedures, and additional documentation.
The web site is available every day, 24 hours a day.

• Send specific questions via email to support@frontierdesign.com.
We do our best to respond promptly (usually within one business day).

• For time-critical questions, you can call Frontier Design Group at
1-800-928-3236 (outside the USA, call 603-448-6283). Phone
support is normally provided weekdays from 9:30 am to 5:30 pm EST.
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Installation

WARNING! The components in your computer and on the
WaveCenter/PCI board are sensitive to electrostatic discharge.
Follow these precautions to avoid damage caused by static
electricity —

• Leave the WaveCenter/PCI board in its anti-static wrapping until
you’re properly grounded.

• To become grounded, make sure the computer is off but leave
its power cord plugged in.  Remove the cover, and touch the
computer’s metal chassis.

• Only handle the WaveCenter/PCI board by its edges and
metal bracket.

Installing WaveCenter/PCI
WaveCenter/PCI requires one PCI slot in your computer.
1. Remove the protective plugs from WaveCenter/PCI’s two optical ports.

2. Make sure the computer is off (but leave its power cord plugged in),
and then remove its cover.

3. Using a screwdriver, remove the blank metal bracket from an empty PCI
slot in the computer, and verify that the motherboard has no protruding
components that would obstruct the WaveCenter/PCI connectors.

4. Insert the WaveCenter/PCI board into the empty PCI slot, and secure the
WaveCenter/PCI bracket with a mounting screw.

5. If your computer has a CD-ROM or DVD drive with a 2-pin digital audio
output, you can connect it internally to the WaveCenter/PCI board using
the CD-ROM cable included with WaveCenter/PCI. Push one end of the
cable into the drive’s output connector until it clicks into place.
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6. Route the CD-ROM cable inside the computer to WaveCenter/PCI, and
push the other end of the cable into WaveCenter/PCI’s internal CD-ROM
connector (labelled CD-ROM) until it clicks into place.

Note:  Not all CD-ROM and DVD drives have a 2-pin
digital audio output, and some have the connector but it
isn’t active (such as many Memorex drives).

For a list of compatible drives, you can refer to the
Frequently-Asked-Questions (FAQ) page on our web site
(http://www.frontierdesign.com).

7. Replace the cover, and restart your computer.  As it starts up,
Windows detects the presence of the new hardware, and automatically
opens an installation wizard. In Windows 95, it’s the “Update Device
Driver” wizard. In Windows 98, it’s the “Add New Hardware” wizard.

8. Follow the instructions in the wizard, letting Windows search for the best
driver for your device. You’ll need to insert the WaveCenter/PCI Software
disk into the floppy drive and click the “Next” button as the wizard
leads you through the driver installation process.

9. When the wizard indicates that the WaveCenter/PCI Audio Device is
installed, click the “Finish” button.

10. After the installation is finished, remove the floppy disk and keep it in a
safe place in case you ever need to re-install WaveCenter/PCI.

Note: WaveCenter/PCI ships with its MIDI ports disabled
(to avoid a Windows 95 bug that crashes the system if
more than 11 MIDI ports are active).

For details on enabling WaveCenter/PCI’s MIDI ports,
please refer to the ‘System Tab’ section of the Software
Reference chapter later in this Guide.

When WaveCenter/PCI is installed, its icon appears in the
Windows Taskbar (usually near the bottom right of your screen).
Double-clicking the icon opens the WaveCenter/PCI control panel.
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Your WaveCenter/PCI shipped with the most recent software available
at the time. The version number appears below the Frontier Design
Group logo on the System tab of the WaveCenter/PCI control panel.
See “Software Reference” later in this Guide for more details.

Updating WaveCenter/PCI Software
The latest version of WaveCenter/PCI software is always available on
our web site, and you can download it from there for free. You can
also register on the web site to automatically receive email whenever
the WaveCenter/PCI drivers are updated.

To install the latest version of WaveCenter/PCI software:
1. Go to our web site (http://www.frontierdesign.com) and download the

latest software, which is contained in a compressed (zip) file. If
necessary, you can also download a copy of WinZip.

2. Insert a blank, formatted floppy disk into your computer’s floppy drive.

3. Open the zip file, and extract the enclosed WaveCenter/PCI files onto a
floppy disk (and then leave the disk in the floppy drive).

4. Open the Windows Control Panel (StartgSettingsgControl Panel), and
double-click the System icon.

5. When the System window appears, select the “Device Manager” tab.

6. Click the ‘+’ next to “Sound, video, and game controllers” to open that
part of the device tree.

7. Select “WaveCenter/PCI Wave and MIDI Driver,” and click ‘Properties.’

8. When the WaveCenter/PCI Properties window appears, select the
“Driver” tab.

9. Click the ‘Update Driver…’ button, and follow the wizard’s instructions,
letting Windows search for the best driver for your device.
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Installing Cool Edit Pro SE
WaveCenter/PCI comes with a copy of Cool Edit Pro SE, a multichannel
recording and editing application created by Syntrillium Software.
Cool Edit Pro SE is easy to learn and fun to use.

To install Cool Edit Pro SE:
1. Insert WaveCenter/PCI’s CD-ROM into your computer’s CD-ROM drive.

Your browser will automatically open the WaveCenter/PCI Software
Sampler home page from the CD-ROM.

(If your browser doesn’t automatically open the CD-ROM, you can
open it manually by navigating to the “\Frontier\Default.htm” file
on the CD-ROM and double-clicking on it.)

2. When the home page appears, follow its instructions to install
Cool Edit Pro SE and the demo versions of other software.

3. After the installation is finished, remove the CD-ROM and keep it in a
safe place in case you ever need to re-install Cool Edit Pro SE.

This application is a limited version of Cool Edit Pro. The SE version
supports only 10 (mono or stereo) tracks of audio and has no DSP
effects. The CD-ROM includes details about how to upgrade your SE
version to Cool Edit Pro, complete with 64 audio tracks and more than
30 high-quality DSP effects.
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Connecting to Other Devices
WaveCenter/PCI has several types of connectors on it. Here are some
suggestions for using them.

— Optical ports and cables —

WaveCenter/PCI ships with plastic plugs covering its optical input and
output connectors. Before installing WaveCenter/PCI in your computer,
you can remove the plugs by pulling them out of the connectors.

The optical ports accept standard TOSLINK™ optical cables. You can
purchase optical cables in lengths up to 10 meters (33 feet) from
Frontier Design Group. Many optical cables have small flexible plastic
covers on their tips to prevent scratches. Make sure you remove the
plastic covers before connecting the cable to an optical port.

The optical connectors are flat on one edge and rounded on the
other, so if the cable doesn’t easily snap into the port, rotate the end
of the cable 180° and try again.

You can connect either end of an optical cable to any optical port, as
long as you’re connecting an output to an input. The direction of an
optical signal is easy to verify because optical outputs emit red light.

optical input

optical output

8-pin connector

coax output

for digital audio inputs A1–A8

for digital audio outputs A1–A8

for 2-in/2-out MIDI breakout cable

coax input for digital audio inputs S1, S2

for digital audio outputs S1, S2

OU
T

IN
M

ID
I
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The light itself is not dangerous, since TOSLINK and ADAT optical
ports use light-emitting diodes (LEDs) rather than laser light.

WaveCenter/PCI’s optical ports can be used in either 8-channel or
2-channel mode.

• The 8-channel ADAT mode lets you connect WaveCenter/PCI to digital
mixers, multitrack tape machines, multichannel external A/D and D/A
converter boxes such as Tango24 and Zulu (also from Frontier Design
Group), and other devices that use 8-channel ADAT optical I/O.

• The 2-channel SPDIF mode lets you connect WaveCenter/PCI to DAT
machines, CD players, MiniDisc recorders and other devices that use
2-channel SPDIF optical I/O.  See the “Software Reference” chapter
later in this Guide for more details.

— SPDIF cables —

Standard audio cables have twisted-pair wire rather than coaxial
cable, and are not recommended for use with SPDIF (Sony/Philips
Digital Interface Format) signals.  Although they have the correct
connector on each end, and may work over short distances, they are
not reliable for SPDIF data streams. The reason is related to the
differences between audio and SPDIF signals — audio signals contain
frequencies in the tens of kiloHertz, but SPDIF signals contain
frequencies in the tens of megaHertz, much like a video signal.

— 8-pin port and cables —

WaveCenter/PCI’s 8-pin port is for MIDI I/O. It connects to the MIDI
breakout cable that’s included with WaveCenter/PCI, providing four
standard 5-pin MIDI connectors. Since MIDI inputs and outputs look
the same, make sure you check the labels and connect your MIDI
cables to the appropriate jacks.

For reliable SPDIF connections, especially over distances longer
than a meter, you should use 75-ohm coax video cables or
cables that are manufactured specifically for SPDIF use.
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Uninstalling WaveCenter/PCI
To uninstall WaveCenter/PCI, you need to remove the driver and
control panel software, and remove the WaveCenter/PCI hardware.

— Removing the software —

1. Open the Windows Control Panel (StartgSettingsgControl Panel), and
double-click the System icon.

2. When the System window appears, select the “Device Manager” tab.

3. Click the ‘+’ next to “Sound, video, and game controllers” to open that
part of the device tree.

4. Select “WaveCenter/PCI Wave and MIDI Driver,” and click ‘Remove.’

5. When prompted to “Confirm Device Removal,” click ‘OK’ to remove the
driver software.

6. To remove the control panel software, open the Windows\System folder
and delete the “WaveCenterPCI.cpl” file.

— Removing the hardware —
1. Make sure the computer is off (but leave its power cord plugged in),

and then remove its cover.

2. Disconnect the internal CD-ROM cable from the WaveCenter/PCI board.

3. Remove the mounting screw that holds the WaveCenter/PCI bracket in
the computer.

4. Lift the WaveCenter/PCI board straight out of its PCI slot.

5. Insert the plastic protective plugs into the two optical ports, and put the
WaveCenter/PCI board into an antistatic bag.

6. Replace the blank metal bracket and the computer’s cover, and restart
your computer.
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Tutorial
This tutorial uses Cool Edit Pro SE to demonstrate some features of
WaveCenter/PCI.

During installation, you probably created a Cool Edit Pro program
group. If so, you can open the application from the Start menu
(StartgProgramsgCool Edit ProgCool Edit Pro Special Edition).

If you haven’t used Cool Edit Pro before, please become familiar with it
first. To learn from its online documentation, select ‘Overview…’ from
the Help menu, click the ‘Contents’ button and open a topic such as
‘Getting Started’ or ‘Navigating Cool Edit Pro.’
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Preparing for Playback
This tutorial assumes you’re using Tango24 as a D/A converter for
WaveCenter/PCI, but any external D/A converter can be used instead.

If you don’t have a Tango24, see “Playback & Recording Devices” in
the “Using WaveCenter” chapter for other setup suggestions. In all
cases, the best setup for tutorial playback has WaveCenter/PCI as the
sample clock master at 44.1kHz, and the external device slaved to
WaveCenter/PCI.

1. Connect an optical cable from WaveCenter/PCI’s optical output to the
Tango24 optical input.

2. Set the Tango24 clock switch (on the front panel) to ‘Optical’ so the
Tango24 will be slaved to WaveCenter/PCI’s optical output.

3. Make sure the Tango24 analog outputs are properly connected to your
monitoring system.

4. To open WaveCenter/PCI’s control panel, double-click its
icon in the Taskbar. (Or from the Start menu, navigate
to SettingsgControl Panel, and double-click on the
“WaveCenterPCI” icon.)

5. In the WaveCenter/PCI control panel, make
sure the Clock Source is set to ‘Internal’ (so
WaveCenter/PCI is the sample clock master)
and set the Sample Rate to ‘44.1kHz.’

to analog inputs
of mixer

analog outs

ADAT out ADAT in
computer with

WaveCenter/PCI tango24
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Playing a Sound
1. Open Cool Edit Pro SE (CEP) and make sure you’re in

the ‘Edit Waveform’ view.  (F12 toggles between the
‘Edit Waveform’ and ‘Multitrack’ views.)

2. Go to OptionsgSettings… and open the
Devices tab.

3. Set the ‘Waveform Playback’ field to the desired
stereo output (for example, ‘A 1:2 WC/PCI’ to use
WaveCenter/Tango24 outputs 1 & 2) and click ‘OK.’

4. Open any sound file (.wav file) on your system. If you don’t have a
favorite sound file, you can go to FilegOpen… and navigate to
C:\Windows\Media, where you should find ‘The Microsoft Sound.wav’.
When you double-click on the sound file, its waveform should appear in
the CEP window.

5. Click the Play button (near the bottom left of the CEP window)
to hear the sound.

When the sound is playing, the ‘Clock/Device Status’ tab in the
WaveCenter/PCI control panel should show bright green status
icons for digital outputs A 1:2.
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Editing the Sound
1. In the CEP window, go to EditgSelect Entire Wave, and then

EditgCopy.

2. Click at the end of the waveform, and then go to EditgPaste.

3. Go to ViewgMultitrack View, and then FilegNew Session… and make
sure that 44100, Stereo, and 16-bit are selected. Click ‘OK.’

4. Click near the beginning of Track 1 to indicate where you’ll be inserting
the edited waveform.

5. Go to the Insert menu and select the name of your file. Your edited
waveform should appear on Track 1.

6. Go to OptionsgDevice Preferences… and map the CEP Playback
devices to WaveCenter/PCI, as shown here. Click ‘OK.’

7. In the control area at the left of
Track 1, click the grey button with
the blue number on it to open the
‘Playback Device’ window.

8. Select the desired output device (for
example, ‘A 5:6 WC/PCI’) and click ‘OK.’
(This is how you route tracks to
WaveCenter/PCI output channels in CEP.)

9. Click the Play button to playback Track 1.
You should hear the sound play twice.
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Setting Up to Record
You can record additional tracks in your CEP session by transferring
digital audio from an ADAT, DAT or CD player.  Or you can record
live audio through a digital mixer’s analog inputs, an external A/D
converter, or by using the A/D converters in an ADAT or DAT machine.

This tutorial assumes you’re using Tango24 as an A/D converter for
WaveCenter/PCI, but any external A/D converter can be used instead.

If you don’t have a Tango24, see “Playback & Recording Devices” in
the “Using WaveCenter” chapter for other setup suggestions. In all
cases, connect the external device’s digital output to one of the
WaveCenter/PCI audio inputs. During setup, look at the input status
indicators (in the Clock/Device Status tab of the WaveCenter/PCI
control panel) to verify that you’re receiving proper digital input.

1. Connect the Tango24 optical output to WaveCenter/PCI’s optical input.

2. Set the Tango24 clock switches to “Internal 44.1kHz” so Tango24
is the sample clock master.

continuedè

Note: If you only have one digital tape machine, you’ll be able
to record during this part of the tutorial, but without hearing the
sounds recorded previously (because you can’t simultaneously
use the A/D and D/A converters in an ADAT or DAT machine).
To record and play back simultaneously, you’ll need two tape
machines, a digital mixer, or an external converter such as
Tango24 or Zulu.

from analog outputs
of mixer

analog ins

ADAT out ADAT in

ADAT in ADAT out
tango24

computer with
WaveCenter/PCI
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3. In the ‘Clock/Device Status’ tab of the WaveCenter/
PCI control panel, set the Clock Source to ‘Dig In
ADAT’ so the computer is slaved to the Tango24
optical output.

4. Verify that all three of WaveCenter/PCI’s ‘Opt’ input indicators are green
(meaning that the signal is present, it’s the correct format, and
WaveCenter/PCI’s clock  is
locked to the input).  If any
indicator is red, refer to the
“Software Reference” chapter
later in this Guide.

5. In CEP, use F12 or the View menu to select ‘Edit Waveform’ view.
(We’ll use ‘Edit Waveform’ view to check the input level, and then we’ll
use ‘Multitrack’ view to actually record.)

6. Go to OptionsgSettings…gDevices, set the
‘Waveform Record’ field to the appropriate input (for
example, ‘A 3:4 WC/PCI’ to use Tango24/WaveCenter
inputs 3 & 4), and click ‘OK.’

7. Open the View menu and make sure
‘View Level Meters’ is checked.

8. Right-click on the horizontal meters (at the bottom of the CEP window)
and select ‘Start/Stop Meter’ from the pop-up menu.

9. Connect the instrument or microphone to the appropriate input, and
adjust the input level so it’s hot without clipping.  When the level is set,
select ‘Start/Stop Meter’ again or click the Stop button to turn off
metering.
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Recording a Track
1. Use F12 or the View menu to select ‘Multitrack’ view.

2. Go to OptionsgDevice Preferences… and map the WaveCenter/PCI
inputs to the CEP Recording devices, as shown here. Click ‘OK.’

3. Click the Track 2 grey button with
the red number on it to open the
‘Recording Device’ window.

4. Select the appropriate input device (for
example, ‘A 3:4 WC/PCI’), click ‘Stereo’ to
indicate that we’ll be recording both input
channels, and click ‘OK.’ (This is how you
route inputs to tracks in CEP.)

5. To record-enable Track 2,
click its red ‘r’ button.

6. Click the Record button (near the bottom left of the
CEP window) to begin recording, and play the tape
or perform live. While recording, the input status
icons for ADAT channels 3:4 in
WaveCenter/PCI’s control panel
should be bright red, and you
should also hear the audio on
Track 1.

7. Click the Stop button when you finish recording. In a moment, the new
waveform should appear on Track 2.

8. To disable recording on Track 2, click its red ‘r’ button again.
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   Using WaveCenter/PCI
This chapter includes information about using WaveCenter/PCI with
other devices for recording and playback.

Synchronization
Every digital audio system operates at a particular sample rate,
such as 44,100 samples per second (44.1kHz) for CDs. The sample
rate can be explicitly transmitted between devices (using BNC word
clock, for example) or it can be embedded in a digital audio stream
that uses a self-clocking format (ADAT optical, SPDIF, or AES/EBU).
The sample rate can also be derived from NTSC or PAL video signals.

When two or more digital audio devices transfer data, one and only
one of them should be used to set the sample rate. This device can
have a variety of names — system clock source, sync source, sample
clock master, audio clock master, or word clock source.  The master
device uses an internal oscillator to set the sample rate.  All other
devices must be synchronized (slaved) to the sample clock master, so
their digital clocks are locked to the master clock.

No two oscillators run at exactly the same rate, even if they’re both
44.1kHz oscillators (for example). Therefore, if two devices in a
system are set to internal sync, each using its own internal oscillator,
one is inevitably a bit faster than the other.  As a result, samples are
lost or duplicated during the transfer, corrupting the audio.

When one device (the slave) gets its sample rate from another device
(the master), we say that the slave device is locked  to the master.  In
contrast, when two devices are operating at independent sample
rates, they are slipping  relative to each other.  When multiple sample
rates are detected, some devices mute, some generate clicks and
pops, and some exhibit completely erratic behavior.

REMEMBER!  Any digital audio system must always have
exactly one sample clock master, which should determine the
sample rate for all devices in that system.  If the sample rates
don’t match, you’ll hear glitches, dropouts, or nothing at all.
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Some devices (such as DVD and CD-ROM drives, and most DAT
machines) are automatically set to “Internal” sync, and therefore
must be the master device. To transfer audio between the computer
and a DAT machine, DVD or CD-ROM drive, set the WaveCenter/PCI
clock source to “Dig In SPDIF.”

Some devices (such as Frontier Design’s Zulu) must always be slaved
to another device. So if you’re using WaveCenter/PCI with Zulu, set the
WaveCenter/PCI clock source to “Internal.” Other devices (such as
Frontier Design’s Tango24 and WaveCenter/PCI) can be either the
master or a slave.

Illustrations
The following illustrations show some synchronization settings that
work well, and two examples that don’t work. In each usable system,
exactly one device is set to “Internal” sync, and all other devices are
slaved to that device.

audio

audio + sync

Clock Source: Internal

computer with
WaveCenter/PCI

(always slaved to its optical input)

ZULU

audio + syncClock Source: Dig In SPDIF (always slaved to its optical input)

computer with
WaveCenter/PCI

DAT
(internal sync)

SPDIF coax
OUT

SPDIF coax
IN

ZULU

Example 2:  The DAT machine is the master;
Zulu is slaved to WaveCenter/PCI, which is slaved to the DAT machine.

Example 1:  WaveCenter/PCI is the master;
Zulu is slaved to WaveCenter/PCI.



    WaveCenter/PCI User’s Guide       20

computer with
WaveCenter/PCI

audio + syncClock Source: Internal

audio + sync

clock source: Internal

Example 5:  This example does NOT work because
both devices are set to “Internal” (there are too many masters).

audio

audio + sync

Clock Source: Internal clock source: Optical
(or External)

computer with
WaveCenter/PCI

computer with
WaveCenter/PCI

audio + sync

audio

Clock Source: Dig In ADAT clock source: Internal

Example 3:  WaveCenter/PCI is the master;
the digital mixer is slaved to WaveCenter/PCI.

Example 4:  the digital mixer is the master;
WaveCenter/PCI is slaved to the digital mixer.
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audio

audio + sync

Clock Source: Internal clock source: Optical

TANGO24

computer with
WaveCenter/PCI

computer with
WaveCenter/PCI

audio + sync

audio

Clock Source: Dig In ADAT clock source: Internal 44.1 or 48 kHz

TANGO24

Example 6:  WaveCenter/PCI is the master; Tango24 is slaved to WaveCenter/PCI.

Example 7:  Tango24 is the master; WaveCenter/PCI is slaved to Tango24.

Example 8:  This example does NOT work because each
device expects sync signals from the other device (there is no master).

computer with
WaveCenter/PCI

audio

audio

clock source: Optical
(or External)

Clock Source: Dig In ADAT
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Playback & Recording Devices

You can use a variety of devices to play through WaveCenter/PCI’s
outputs and record through its inputs. Here are some general
guidelines for several types of external devices — digital mixers,
external converters, ADAT-compatible multitrack decks, DAT machines,
and DVD or CD-ROM drives.

See “Synchronization” earlier in this chapter for more details about
clock sources and sample rates.

— Digital Mixers —

For playback from WaveCenter/PCI, it’s best to slave the digital mixer
to WaveCenter/PCI. Although some digital mixers prefer to be the
sample clock master device, all have a menu option that lets the mixer
be slaved to one of its digital inputs.

For recording into WaveCenter/PCI, digital mixers can digitize mic-level
or line-level inputs, and route them directly to mixer outputs that are
connected to WaveCenter/PCI inputs. You can use the mixer to add EQ
or effects, and create submixes before recording.

In each case, make sure you route the appropriate channels to the
appropriate outputs, with sufficient level on each channel. Most mixers
have internal metering to help you verify the signal path and levels.

— External Converters —

If you’re using Frontier’s Tango24 or Zulu converters, you’ll need to
select ADAT pairs (A 1:2, A 3:4, A 5:6, A 7:8) as the playback and
recording devices in your audio applications (Cool Edit Pro, Cakewalk,
Cubase, and so on). If you’re using a 2-channel external converter
instead, make sure you select SPDIF (S 1:2 rather than an ADAT pair)
as the playback and recording devices in your audio applications.

Since Zulu must always be slaved to its optical input, leave the
WaveCenter/PCI clock source set to “Internal” regardless of whether
you’re using Zulu for playback or recording.
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— ADAT-Compatible Multitrack Decks —

To use an Alesis, Panasonic or Fostex multitrack deck as a D/A
converter (for playback from WaveCenter/PCI), set it to ‘All Input’
monitoring, ‘Digital’ input, and ‘Dig 44.1kHz’ clock source. On an
original (black faceplate) ADAT machine, enabling ‘Digital In’
automatically sets the clock source to its optical/digital input. On an
ADAT-XT, use the Clock Select button to choose ‘Dig 44.1kHz.’

To use an Alesis, Panasonic or Fostex multitrack deck as an A/D
converter (for recording into WaveCenter/PCI), set it to ‘All Input’
monitoring, ‘Analog’ input, and ‘Int 44.1kHz’ clock source. An original
(black faceplate) ADAT machine automatically switches to internal
sync when its ‘Digital In’ button is off. If you’re using a BRC or an
original ADAT machine, you set the clock to 44.1kHz by pitching down
to ‘-147 cents.’

— DAT Machines —

To use a DAT machine as a D/A converter (for playback from
WaveCenter/PCI), set its input source to ‘Digital’ and enable its
‘Record-Pause’ mode to monitor the digital inputs. In your audio
application, make sure you select SPDIF (S 1:2 rather than an ADAT
pair) as the playback device.

To use a DAT machine as an A/D converter (for recording into
WaveCenter/PCI), set its input source to ‘Analog’ and enable its
‘Record-Pause’ mode to monitor the analog inputs. In your audio
application, make sure you select SPDIF (S 1:2 rather than an ADAT
pair) as the recording device.

Note: Unlike Tango24 or Zulu, you cannot simultaneously
use both the A/D and D/A converters in an ADAT-compatible
multitrack deck. To play and record simultaneously, you’ll
need to use separate external playback and recording devices.
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The input monitoring function works better on some DAT machines
than on others. To enable input monitoring, a DAT may:

• not need to have a tape loaded (ideal)
• need to have a tape loaded, but not need to spin up its head (OK)
• need to have a tape loaded, and need to spin up its head (unfortunate)

The last case is particularly undesirable because the spinning head
will unnecessarily wear both the tape and head. If you’re considering
purchasing a DAT machine, ask whether it must have a tape loaded
and whether it needs to spin up its head to enable input monitoring.

— DVD and CD-ROM Drives —

Some DVD and CD-ROM drives have a 2-pin
digital audio output. If you connected such a drive in
your WaveCenter/PCI installation, you can select it as the ‘S 1:2’ input
in the Clock/Device Status tab of the WaveCenter/PCI control panel.

Since the drive cannot synchronize to an external sample rate, it must
be the master device. Therefore, to record into WaveCenter/PCI from
a DVD or CD-ROM drive, you also need to set the WaveCenter/PCI
clock source to ‘Dig In SPDIF.’

If you also want to monitor the input while recording, open the
WaveCenter/PCI Patchbay tab and route the SPDIF inputs to the
desired optical or coax (SPDIF) outputs.

Some CD-ROM drives only have active output if an audio CD is loaded
and playing in the drive, so make sure a CD is actually counting
playback time before checking the input status indicators in the
WaveCenter/PCI control panel.

Some audio applications include CD transport controls. For example,
Cool Edit Pro lets you select “Show CD Player” from the View menu.

Note: Unlike Tango24 or Zulu, you cannot simultaneously
use both the A/D and D/A converters in a DAT machine. To
play and record simultaneously, you’ll need to use separate
external playback and recording devices.
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   Software Reference
Whenever WaveCenter/PCI is installed in your system, an icon with two
bars appears in the Windows Taskbar (usually at the bottom of the
screen). The top bar lights red whenever any WaveCenter/PCI input is
active, and blinks whenever an active input has an error (see the
“Clock/Device Status Tab” section for details about
input errors). The bottom bar lights green whenever
any WaveCenter/PCI output is active.

Double-clicking on the icon opens the Clock/Device Status
tab. You can also right-click on the icon to display a menu that lets
you go directly to the Clock/Status, Patchbay, or System tab.

To open WaveCenter/PCI’s control panel from the Start menu,
navigate to SettingsgControl Panel, and double-click on the
“WaveCenterPCI” icon.

The control panel includes three tabs — Clock/Device Status,
Patchbay, and System. Each tab contains several sections, each
with one or more fields.

Clock/Device Status Tab
The Clock/Device Status tab contains four sections — Clock Source,
Sample Rate, Digital Input Status, Digital Output Status.
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— Clock Source —

The audio clock can come from one of three
sources.

For more information about audio clocks and sample rates, see
‘Synchronization’ later in this chapter.

— Sample Rate —

In this section, a drop-down box lets you select
the expected sample rate (44.1 or 48kHz).  If the ‘Lock’ box is
checked, then applications can only use that sample rate.  For
example, if the sample rate is locked at 48kHz and you try to play a
44.1kHz sound, an error message appears (though it may not clearly
state that the sample rate is incorrect). The Sample Rate section also
displays the actual current sample rate as measured by the computer.

— Digital Input Status —

This section displays the audio input status in the form of error
indicators, mappings from physical inputs to logical inputs, and
channel indicators.

On the left are three rectangular error indicators for each of
WaveCenter/PCI’s physical inputs (Opt and Coax).

A red indicator represents an error, and green
means “good to go.” A slash across a green
indicator means that at least one error was detected since the
errors were last cleared. To remove all slashes, click ‘Clear Errors.’

Internal With this setting, the computer is the sample clock master,
running at either 44.1 or 48kHz, depending on the
Sample Rate selection

Dig In ADAT With this setting, the 8-channel ADAT device connected to
WaveCenter/PCI’s optical input is the sample clock master.

Dig In S/PDIF With this setting, the stereo SPDIF device (connected to the
coax, optical or CD-ROM input) is the sample clock master.
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From left to right, the indicators are:

If WaveCenter/PCI’s sample rate is almost the same as the incoming
audio clock, but not perfectly locked, the Slip indicator flashes red
periodically. A slash appears across the green indicator until you click
‘Clear Errors.’

By default, the physical inputs (Opt and Coax) are mapped directly to
the logical devices (A 1:2, A 3:4, A 5:6, A 7:8, and S 1:2) that you’ll
use within your recording/playback applications.

The stereo device ‘S 1:2’ (in SPDIF format) can come from any
physical input — the optical input, the RCA (coax) input, or the
internal DVD/CD-ROM 2-pin connector. You can select the stereo
input device from the drop-down box next to ‘S 1:2.’

The physical-to-logical mapping lines
automatically change to graphically reflect your selection.

The ‘Channels In Use’ indicators show activity on each input channel.
If an input channel is in use, its indicator is bright red.

Signal green = input signal active
   red = input signal inactive

Format
(Fmt)

green = valid digital audio format detected
   red = error in digital audio signal format
         (for example, feeding an SPDIF signal to an ADAT input)

Slip green = WaveCenter/PCI is locked to incoming audio clock
   red = WaveCenter/PCI’s sample rate is different than the
             incoming audio clock
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— Digital Output Status —

This section shows which output channels are active, and the mapping
from logical output devices to physical outputs. When an output
channel is playing data, its indicator is bright green.

The stereo SPDIF stream is always present on WaveCenter/PCI’s RCA
(coax) output. You can also route the SPDIF stream to the optical
output. Clicking on the button next to Optical Out toggles the optical
output between 8-channel mode (ADAT optical) and 2-channel mode
(SPDIF optical).

The logical-to-physical mapping lines automatically change to
graphically reflect your selection.
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Patchbay Tab
The Patchbay tab lets you route any of WaveCenter/PCI’s audio inputs
to any of its audio outputs. You can use the Patchbay tab both for
input monitoring and for real-time digital audio format conversions.

For example, you can monitor WaveCenter/PCI’s “Optical A 5:6” inputs
through the SPDIF coax outputs, as shown here.

WaveCenter/PCI inputs appear in the top row of icons; outputs appear
in the bottom row. To create a patch, click on an input icon and then
click on an output icon, or drag the cursor from an input to an output.
Lines automatically appear to indicate the routing(s).

To delete a particular routing, double-click on its input or output icon.
To undo all the current routings, click the “Clear patches” button.

To save the current routings in the Patch Library, click “Save…” and
type a name for the patch. You can then restore those routings by
selecting the saved
patch from the
drop-down box.

To remove a saved patch from the Library, select the patch in the
drop-down box and then click the “Delete” button.
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System Tab
In addition to displaying the WaveCenter/PCI software version and
contact information for Frontier Design Group, the System tab lets you
enable the MIDI ports and set other options.

Clicking the ‘Frontier Web Site’ button launches access to our web site
if your PC has an internet link and web browser.

The System tab also has a checkbox labelled “Keep WaveCenter/PCI
On Top.” When the box is checked, the control panel remains in front
of other windows on your screen.
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— MIDI Mode —

In order to avoid a Windows 95 limitation (see warning below),
WaveCenter/PCI ships with its MIDI ports disabled.

This MIDI limitation is not a problem in Windows 98.

To enable WaveCenter/PCI’s MIDI ports, set the MIDI mode to ‘2x2’
and then reboot the computer. To disable the
MIDI ports, set the MIDI mode to ‘Disabled’ and
then reboot the computer.

— Output Channel Status —

The Output Channel Status section lets you set
the channel status bits for WaveCenter/PCI’s
stereo outputs to either Consumer (SPDIF)
or Pro (AES/EBU). The default is SPDIF.

If you have an external SPDIF-to-AES/EBU level converter such as the
Hosa CDL-313, you can use it with WaveCenter/PCI’s Pro (AES/EBU)
setting to generate true AES/EBU output.

WARNING!  Windows 95 is limited to a maximum of 11
MIDI input ports and 11 MIDI output ports. Adding
WaveCenter/PCI’s MIDI ports may put your system beyond
the limit, causing it to crash with the “blue screen” message
“MSGSRV32 caused a general protection fault…”.

There is no easy way to recover from this crash, so before
enabling MIDI ports in the WaveCenter/PCI control panel,
make sure your Windows 95 system doesn’t already have 9
other MIDI ports enabled.
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— Buffer Size —

The Buffer Size indicates how often data is processed
between the WaveCenter/PCI hardware and its driver.

Smaller buffer sizes yield faster response times (lower latency), which
most noticeably affect audio functions such as monitoring inputs in
the Patchbay or using WaveCenter/PCI’s ASIO driver in Cubase VST.
Larger buffer sizes provide more protection against audio glitches.
The default setting is 256 samples. We recommend that you set the
buffer size as large as possible while attaining suitable latency for
your audio.

— ASIO Resolution —

You can set the resolution for recording and playback
to ‘16 bit’ or ‘24 bit’ when using WaveCenter/PCI’s
ASIO driver in applications such as Cubase VST. You may also need to
set the resolution in the application itself. For example, to record and
play 24-bit audio in Cubase VST, you have to enable its ‘24-bit’
button.

Note:  You must close all audio applications before you
change WaveCenter/PCI’s buffer size. The new setting takes
effect when you restart the application(s).

Note:  You must close all audio applications that use the ASIO
driver before you change WaveCenter/PCI’s ASIO resolution.
The new setting takes effect when you restart the application(s).
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ASIO Driver
WaveCenter/PCI’s ASIO driver provides ultra-low latency for real-time
audio functions such as input monitoring and adjusting EQ, pan, and
other parameters in audio applications that utilize ASIO drivers.

To use WaveCenter/PCI’s ASIO driver in Cubase VST:
1. Close Cubase VST, and open the System tab of WaveCenter/PCI’s

control panel.

2. Select the desired Buffer Size and ASIO Resolution settings (described
on the previous page).

3. Open Cubase VST, and select “System…” from the Audio menu.

4. In the ‘Audio I/O’ section of the Audio System Setup window, set the
‘ASIO Device’ field to “ASIO WaveCenter/PCI Driver.”

5. Verify that the sample rate, audio source, number of channels,
and other options are correct. You can try different disk block buffer
sizes in Cubase VST to improve performance (ie, the number of tracks).

6. Click “OK” to close the Setup window.

Note:  To actually record or play 24-bit audio, you must set
WaveCenter/PCI’s ASIO Resolution to ‘24 Bit’ (in step 2) and
you also need to enable the ‘24-bit’ button in Cubase VST.
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  Troubleshooting

This section describes some possible problems, and suggestions for
resolving them.

You can also check our web site (http://www.frontierdesign.com) for
driver updates and application notes.

Problems Possible Solutions

Just installed
WaveCenter/PCI
and it doesn’t
work

There’s probably an IRQ conflict. If so, the channel output status
icons (on the Clock/Device tab of the WaveCenter/PCI control
panel) will be dark green rather than bright green when you try
to play a sound.

WaveCenter/PCI is designed properly for IRQ sharing, but some
other devices aren’t. You can resolve the problem by moving
WaveCenter/PCI to a different IRQ — power down the computer,
move the WaveCenter/PCI card to a different PCI slot, and then
reboot the computer.

No MIDI in/out WaveCenter/PCI’s MIDI ports are disabled by default. To enable
the MIDI ports, open the System tab of the WaveCenter/PCI
control panel, and select MIDI 2x2.

Can’t get audio
from DVD or
CD-ROM

Verify that the drive has a fully-functional 2-pin digital audio
output, and that the cable is properly connected from that
output to WaveCenter/PCI’s internal CD-ROM connector.

In the Clock/Device Status tab of the WaveCenter/PCI control
panel, set the “S 1:2” device to CD-ROM, and set the clock
source to Dig In SPDIF.

Some CD-ROM drives only have active output if an audio CD is
loaded and playing in the drive. Verify that the drive is spinning
and actually counting playback time.
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Problems Possible Solutions

No audio output
(can’t hear
any audio
playback)

Verify that the playback device selected in your application
corresponds to the WaveCenter/PCI output you’re using.

Check the analog signal path to make sure the signal gets to
your headphones/speakers.

If the output “Channels In Use” icons are dark green (rather
than bright green), there’s probably an IRQ conflict. Power down
the computer, move the WaveCenter/PCI card to a different PCI
slot, and reboot the computer.

No audio input
(can’t record
audio)

Verify that the record device selected in your application
corresponds to the WaveCenter/PCI input you’re using.

Check the Input Status icons in the Clock/Device Status tab of
the WaveCenter/PCI control panel —

SIGNAL: If “Signal” is red, verify that the cable is properly
connected from the output of the source device to the
WaveCenter/PCI input, and that the source device is actually
playing audio.

FMT: If “Fmt” is red, the digital audio input format doesn’t
match the selected WaveCenter/PCI input. On the Clock/Device
tab, make sure the settings in the “Digital Input Status” section
match the actual input you’re using. There are four options —

• To record through the RCA (coax) input, set ‘S 1:2’ to Coax.

• To record from a CD-ROM or DVD, set ‘S 1:2’ to CD-ROM.

• To record stereo SPDIF audio through the optical input (from
a DAT machine or minidisc, for example), set ‘S 1:2’ to Optical.

• To record 8-channel ADAT audio through the optical input
(from a digital mixer or an ADAT-compatible multitrack, for
example), set ‘S 1:2’ to Coax (not  Optical).

SLIP: If “Slip” is red, check the clock source settings. Verify that
one (and only one) device is set to “Internal” and that all other
devices are slaved to that device. Some devices (CD-ROM and
DVD drives, and most DAT machines) are automatically set to
“Internal” sync, so to record from one of them, you need to set
the WaveCenter/PCI clock source to Dig In SPDIF.

See the “Using WaveCenter/PCI” and “Software Reference”
chapters earlier in this guide for more details.
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Tuning the System

Because Windows 95 and Windows 98 are general purpose operating
systems, some of the default system settings may not be optimal for
digital audio work. This chapter offers suggestions that may help
improve the performance of your system.

Please check your audio application’s documentation for additional
performance tips. If you have Internet access, you may want to
periodically check your software manufacturer’s web site in addition to
ours (http://www.frontierdesign.com) for updated information.

Disk Drives
Whenever possible, use a large, fast, separate disk for storing your
digital audio. Digital audio consumes a lot of disk space. For example,
5 minutes of an 8-channel, 44.1kHz, 16-bit recording consumes
about 212 MB on your hard disk. With disk prices decreasing all the
time, large disks are quite affordable. Nevertheless, you need to be
sure your disk has enough room for your projects. You may need to
archive older projects to tape or removable disks.

The number of tracks that your software will be able to transfer in real
time depends on the speed of your hard disk subsystem (and your
CPU, of course). The disk subsystem that comes with many desktop
systems should be fine in most cases but for the best performance,
consider a PCI-based Wide UltraSCSI adapter and “AV” (audio-visual)
rated disk drives with at least 7200rpm spindle rates.

Use a separate disk drive for your audio. By keeping your programs,
virtual memory swapfile, and any disk caches on a different drive, you
keep the disk activity associated with those operations separate from
the continuous reading and writing of audio data. This should result in
less head movement and higher overall throughput for your audio.
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Disk Fragmentation
We recommend that you defragment your disk regularly, especially
after heavy editing sessions. Defragmenting reorganizes files into
contiguous areas on the disk, so that the entire file can be accessed
with a minimum number of head movements.  One strategy is to leave
the PC running and defragment the disk at the end of each day.

Data Compression
Don’t use data compression on the drive that stores your digital
audio. Although Windows 95/98 supports data compression  (for
example, the DriveSpace utility that comes with Microsoft’s “Plus!”
add-ons for Windows 95), the compression algorithms generally don’t
work well with digital audio. Furthermore, because the CPU spends
time compressing and uncompressing your files, fewer CPU cycles are
available for mixing tracks in your audio application.

Sporadic Disk Activity
Some applications think they’re doing you a big favor by hanging
around in the background until the last crucial 10 seconds of your
mixdown, when they awaken and start pounding your disk.

Avoid applications and utilities that cause sporadic disk activity, such
as System Agent, Find Fast for Office, Screen Savers, and CD-ROM
“Auto-Insert” Notification. Here are some suggestions for thwarting
them.



    WaveCenter/PCI User’s Guide       38

— System Agent —

System Agent (included in the Microsoft Windows add-on) includes
utilities that scan your disk for errors and perform disk
defragmentation. System Agent allows you to schedule these activities
so they occur at specific times or when you haven’t used your
computer for a period of time. To prevent these disk-intensive
activities from occurring, we recommend that you either disable
System Agent while doing your audio work (right-click its icon in the
system tray of the Task Bar), or schedule the activities to occur when
you’re absolutely sure that you won’t be trying to record and play
audio.

— Find Fast for Office —

If you use Microsoft’s Office products (Word, Excel, PowerPoint,
Schedule, or Access), the “Find Fast” utility was probably installed in
the Windows Control Panel. The utility periodically scans your disks,
building indices of all your Office documents so their names can be
displayed quickly. Unfortunately, the indexing activity could pound
your disks while you’re trying to play back a multitrack recording.

To prevent Find Fast from running, you can either remove it
permanently or disable it temporarily while you work on audio.

• To disable Find Fast permanently, open the Windows “Startup” folder
and delete “Microsoft Office Find Fast Indexer.” (You can use Windows
Explorer to navigate to “C:\Windows\Start Menu\Programs\StartUp.”)

• To disable Find Fast temporarily, open the Windows Control Panel
(StartgSettingsgControl Panel) and double-click the Find Fast icon.
When the Find Fast window appears, select ‘Pause Indexing’ from the
Index menu. When you want to enable Find Fast, select ‘Pause Indexing’
again.
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— Screen Savers —

Few things are worse than having your audio interrupted by the
sudden appearance of a bunch of flying toasters (or some other
screen saver). A screen saver is particularly vexing because its delay
timer silently ticks away when you’re not touching your mouse or
keyboard (when you’re printing your final mix to DAT, for example).

To disable the screen saver, consult its documentation, or try this
procedure: open the Windows Control Panel, double-click the Display
icon, select the “Screen Saver” tab, and click the down arrow next to
the “Screen Saver” box. Select ‘None’ (the first entry) and then click
‘OK’ to confirm the selection.

— CD-ROM “Auto-Insert” Notification —

When this option is enabled, Windows may periodically poll your
CD-ROM drive to see if you’ve changed CD’s, causing the CD-ROM
access light to blink about every five seconds. If Windows Explorer is
open and detects a new CD, you’ll experience a flurry of disk and CPU
activity while the folder and filenames of the new CD are updated in
the display. The CPU activity may cause dropouts in your audio.

If you don’t load a CD during audio operations, you may not
experience this problem, but it’s a nice opportunity to rid your
machine of that annoying flashing LED!

1. Open the Windows Control Panel (StartgSettingsgControl Panel), and
double-click the System icon.

2. When the “System Properties” dialog box appears, click the “Device
Manager” tab and then click ‘+’ to open the “CD-ROM” sub-tree. A list
of installed CD-ROM drives appears (there may be only one in the list).

3. Double-click the line that describes your particular model of CD-ROM
(“NEC CDR-74”  for example).

4. When the “Properties” dialog box appears, click the “Settings” tab and
uncheck ‘Auto insert notification.’

5. Click ‘OK’ to confirm the change, and then close the Control Panel.
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Multi-tasking
Windows 95/98 can run many applications at once, but if you run
more than one at a time, the performance of each individual
application diminishes. Your audio applications are particularly heavy
users of CPU cycles and disk bandwidth, so it’s important to minimize
the use of other high-demand applications. It’s probably OK to run a
word processor in the background while you’re mixing down, but
avoid applications that do a lot of computation or frequently access
the hard disk.

File Caching
Windows 95/98 has built-in file caching which saves your most
recently accessed data in memory. Since file caching is of limited use
in digital audio applications, you may want to restrict the amount of
memory reserved for file caching. Locate the SYSTEM.INI file in your
Windows folder, and open the file in a text editor such as Notepad.
Create (or find and edit) a section named “[VCache]” and make sure
the MinFileCache and MaxFileCache are both set to:

4096 (for a computer with 32MB of RAM), -or-
8192 (for a computer with 64MB or more of RAM)

The values are given in kilobytes (KB) of RAM (2048 means 2MB of RAM).

WARNING! Do not use values for MinFileCache or
MaxFileCache that begin to approach the amount of physical
RAM in your machine. NEVER use values greater than the old
Windows 3.1 limit of 24576 (24 MB).  Microsoft specifically
warns that it does not guarantee performance of the cache at
sizes larger than this and disavows responsibility for data
corruption or loss that may occur. So do we!
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Other Caching Options
There are several other caching options which may affect your PC’s
audio performance —

• You may want to limit the amount of “Read-ahead optimization”
performed by Windows. Open the Control Panel (StartgSettingsg
Control Panel), and double-click the System icon. Select the
“Performance” tab, and click the ‘File System...’ button. When the “File
System Properties” dialog appears, select the “Hard Disk” tab, and
move the ‘Read-ahead optimization’ slider all the way to the left.

• In the same dialog (“File System Properties”), you can specify the
“Typical role of this machine.” In most cases, you’ll want it set to
‘Desktop computer.’

• You may want to disable “write-behind caching.” In the “File System
Properties” dialog, select the “Troubleshooting” tab and check the box
labelled ‘Disable write-behind caching for all drives.’
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Virtual Memory Swapfile
When the demands of multi-tasking exceed the limits of physical
memory on your machine, Windows dynamically changes the size
of the swapfile that it uses to hold code and data. You can improve
audio performance by setting the swapfile parameters manually.

Open the Control Panel, double-click the System icon, select the
“Performance” tab in the System Properties dialog, and click the
“Virtual Memory…” button. When the “Virtual Memory” dialog
appears, select “Let me specify my own virtual memory settings.”

Set the following parameters in the dialog:

Hard disk: choose a disk other than the one you use for digital audio
(if possible)

Minimum: set it to 2.0–2.5 times the size of your system memory
Maximum: set it to the same value you specified for minimum

Leave “Disable virtual memory” unchecked!
(Otherwise, Windows displays a warning.)

Click “OK” to confirm your choices, and close the Control Panel. After
changing this setting, you’ll be reminded that the new settings won’t
take effect until you restart Windows.
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Graphics Acceleration
If you experience glitches during recording or playback, you may have
a video driver problem. If so, try reducing the amount of graphics
acceleration used by Windows. Open the Control Panel, double-click
the System icon, select the “Performance” tab in the System
Properties dialog, and click the “Graphics…”  button. When the
“Advanced Graphics Settings” dialog appears, move the “Hardware
acceleration” slider all the way to the left. Click “OK” to confirm the
setting, and close the Control Panel. After changing this setting, you’ll
be reminded that the new settings won’t take effect until you restart
Windows.

After you’ve rebooted, see if the glitching problem is gone. If so, you
may want to experiment with other settings of the “Hardware
acceleration” slider to regain some of the graphics performance.

32-bit Drivers
To obtain the best possible performance from your disk system, use
32-bit drivers. Generally, the Windows installation replaces real-mode
drivers with 32-bit protected mode drivers. However, there may not
have been any 32-bit drivers that were compatible with your hardware
when Windows was released. To check the driver, open the Control
Panel, double-click the System icon and select the “Performance” tab.
If the “File System” status doesn’t indicate “32-bit,” contact the
manufacturer of your disk controller to get a 32-bit protected mode
driver and install it in your system.
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Windows System Monitor
Windows includes a “System Monitor” utility that displays important
performance information about your machine. If it’s installed, you can
usually find it by following this path in the Start menu:

StartgProgramsgAccessoriesgSystem ToolsgSystem Monitor

When the WaveCenter/PCI driver is loaded, it notifies Windows that it
can collect statistics that indicate how well the system is responding to
WaveCenter/PCI’s requests to read and write audio data.

You can display these statistics and compare them with other
important performance data —
1. Start the System Monitor application (StartgProgramsg

AccessoriesgSystem ToolsgSystem Monitor).

2. Click on the fourth icon in the tool bar (it looks like a funky blue
mountain range) so that data will be displayed in “time-line” format.

3. Select “Add Item…” from the Edit menu.

4. In the “Category” box, click ‘WaveCenter/PCI Performance.’  The list on
the right indicates which performance data can be displayed.

5. Select one or more items from the list and click ‘OK.’  The graphical
display adds the statistics you selected. You may also want to select
items from other parts of the system so you can correlate the
performance of WaveCenter/PCI with other CPU and disk activity.

The following list describes the available statistics.

What if you don’t have System Monitor?

System Monitor is optionally installed as part of Windows 95/98, but every
Windows 95/98 PC can load it. Open the “Add/Remove Programs” control panel
(StartgSettingsgControl PanelsgAdd/Remove Programs). In the “Windows
Setup” tab,  scroll down and select “Accessories.” Its check box will be gray if
some of the accessories aren’t installed. Click the ‘Details…’ button. Scroll
through the list of programs and make sure “System Monitor” is checked. Click
‘OK’ and follow the installation instructions.
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— IRQ Latency —
This statistic indicates the maximum number of audio samples
that have elapsed between the time the WaveCenter/PCI hardware
asked for service and the time Windows began to process the
request. Typically it’s less than 5.

Correlating the system’s response time to interrupts with other system
activity will help you determine if there are other installed devices that
prevent WaveCenter/PCI from being serviced efficiently. To calculate
the absolute latency (accurate to within one sample), divide the IRQ
latency by the current sample rate.

— IRQ Misses —
Normally, this should be zero. An IRQ miss means the WaveCenter/PCI
driver wasn’t given enough time to transfer audio between your PC
and the WaveCenter/PCI hardware, a severe problem indicating that
something in the system is causing gross timing latencies that can’t
be overcome. The result can be brief audio dropouts or pops. Try to
determine whether another device is active when the IRQ misses
occur, and then correct the situation by removing that device or by
not using it while also trying to transfer audio.

— Input Overruns —
This indicates how many errors occurred when WaveCenter/PCI was
ready to transfer newly-recorded information to an application, but
the application hadn’t supplied a buffer in which to write the audio
data. Input overruns are generally caused by an overloaded CPU or a
disk system that can’t keep up with the audio applications.

— Output Underruns —
This indicates the number of times that the driver ran out of data to
send to the digital audio outputs. Generally, it means that the CPU or
disk system couldn’t keep up with the real-time demands of the
application. It’s normal to see a “blip” when playback stops, but an
output underrun in the middle of playback indicates a problem.
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WaveCenter/PCI Specifications
These specifications are subject to revision without notice.

Digital audio inputs 8 channels ADAT optical format (1 TOSLINK optical port)

2 channels SPDIF format from CD-ROM digital output, or
TOSLINK optical port, or RCA (coax) port

Digital audio outputs 8 channels ADAT optical format (1 TOSLINK optical port)

2 channels SPDIF format on the TOSLINK optical output
and on the RCA (coax) output

MIDI I/O 2 MIDI inputs + 2 MIDI outputs; standard DIN-5 connectors
via breakout cable connected to miniDIN-8 port

Sample rates 44.1 and 48 kHz internal, input tracking from 39–51 kHz,
Real-time resampling to support
8, 11.025, 16, 22.05, and 32 kHz output streams

Audio data 8, 16, 20, 24 bit resolution

Software Windows 95/98 device driver (MME, ASIO, GigaSampler)
Control panel for displaying status and setting options

System requirements 1 PCI slot and 1 IRQ

Dimensions 4.7" x 3.4" (12cm x 8.6cm), PCI short card



This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with
the User’s Guide, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that changes and modifications made to the equipment without the
approval of manufacturer could void the user’s authority to operate this equipment.

Frontier Design Group, LLC declares that the multichannel digital I/O card called
WaveCenter/PCI conforms to the following Directives and Standards:

Council Directives:   89/336/EEC, 73/23/EEC
Conformance Standards:   EN55022 Class B, EN50082-1

Manufacturer: Frontier Design Group, LLC
199 Heater Road
Lebanon, NH 03766  (USA)
603-448-6283 voice
603-448-6398 FAX

European Contact: Et Cetera Distribution
Valley House
2 Bradwood Court, St. Crispin Way
Haslingden
LANCS, BB4 4PW, UK
+44 1706 228039 voice
+44 1706 222989 FAX

Declaration of Conformity

Compliance Statement


